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Introduction

The Netherlands Address Data Information
1

Dataset Code: NLD

Approximate Data Size: 52MB

Data Source:
All data, extracts and updates © Koninklijke 
TPG Post and Cendris 2005.

Update Frequency: Quarterly

Expiry:

The quarterly data release dates are:

• March

• June

• September

• December

Data files will expire 8 months after creation. 
For example, March data will expire in 
November of the same year.

Ensure every data update is applied promptly, 
otherwise the data may expire and the product 
will become unusable.





About This Data

This chapter provides detailed information about the NLD dataset.
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Area Covered

The NLD dataset covers all postal addresses within the Netherlands, including 
Postbus (PO Box) addresses.

Address Elements

The following address elements are stored within the NLD data files.

Address Element Example
Input/Output
Element Code

Postbus Postbus 110 B11

House number 8 P11

NEN street Burg v Wijngaardenstr S11

TPG street V Wyngaardenstr S12

Official street Burgemeester van Wijngaardenstraat S13

NEN town/city Amsterdam L21

TPG town/city Amsterdam L22

Unofficial town/city** Amsterdam Noord L23

Province * Noord Holland L11

Postal code 1045 AD C11



Country name* The Netherlands X11

Three character ISO 
country code*

NLD X12

Two character ISO 
country code*

NL X13

Address Element Example
Input/Output
Element Code
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* Elements that only appear in the address if their position is fixed.
** Elements that are only used in searching and will not appear in the address.

Address Element Definitions

Abbreviations

No options to abbreviate elements of the returned address are provided. The street 
type is usually part of the street name. However, the multiple forms of street and 
town/city names (see “Forms of Address” on page 5) provide support for 
abbreviations in these address elements.

Postal code Structure

The Netherlands postal codes take the form ‘NNNN AA’ where ‘N’ represents a 
number and ‘A’ represents a letter. The numeric component represents the district, 
and the two letters represent the postal code area. For example:

1024 TX

A postal code may contain many streets, but for built-up streets the combination of 
house number and postal code is unique. If a street does not contain any buildings 
the postal code comprises of only four digits.



Forms of Address

Forms of address are referred to as Country Views in QuickAddress Pro version 6 
and earlier.

There are three Forms of address stored in the Netherlands data files:
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The Form of address determines which address elements are used in the returned 
address. For the Netherlands dataset, the street and town/city address elements 
vary according to the Form of address selected, as shown in the following table.

The Netherlands Forms of address also differ in how the street and town/city 
elements are displayed, and in the appearance of the diacritic character ‘IJ’, as 
detailed in the following table.

Form of address Information Source

1 Official Local Authority

2 NEN Interior Ministry

3 TPG TPG Post

Form of 
address

Street element 
used

Town/City 
element used

Official Official NEN

NEN NEN NEN

TPG TPG TPG



Form of 
address

Street element Town/City element ‘IJ’

Official
maximum of 43 
characters in title case

maximum of 24 
characters in upper case

written as IJ

NEN
maximum of 24 
characters in title case

maximum of 24 
characters in upper case

written as IJ

maximum of 17 letters maximum of 18 letters in 
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Instructions on how to change the Form of address in QuickAddress products are 
provided in the chapter “Using This Data” from page 9.

Default Address Format

The default Netherlands address format is the same for all Forms of address. It 
contains two or three lines:

Company
Delivery line
Final line

The final address line consists of the postal code and the town/city name (in capitals), 
separated by two spaces.

The delivery line consists of either the postbus number, or the street and house 
number. If the premises information contains a house number extension, this is 
displayed after the house number. The house number and the house number 
extension should be separated by a hyphen. For example:

Daarleseweg 12-B

If the address contains company information, this is displayed on the first line.

The example below shows a returned address in the default address layout:

Daarleseweg 12-B
7683 RE  DEN HAM OV

TPG
in upper case upper case

written as Y



About DataPlus Information

You can configure your QAS products to use the DataPlus sets that are available for 
NLD data. Please refer to the relevant section of the product documentation for 
information on configuring QAS products to return DataPlus information.

Each DataPlus set is divided into one or more items. QAS products can be 
configured to return these items via the Configuration Editor (using the element 
name) or the configuration file (using the code name). This section details the 
DataPlus sets currently available for NLD address data.
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DataPlus Sets for NLD Address Data

The following DataPlus sets are available with NLD Address Data:

• TPG KIX Barcode DataPlus

• MOSAIC DataPlus

TPG KIX Barcode

Identifier:NLDBAR

This DataPlus set returns barcodes to an underlying application. The barcode is a 

compact representation of the address.

To display barcodes correctly, the Customer Barcode font is required. The font 
(custcode_.ttf) is supplied with QAS products.

The Customer Barcode font is compatible with Windows only. If you are using a 
different platform, the barcode will be displayed as a string of digits.

Element Code Description

TPG KIX Barcode TPGKIXBar
Barcode sequence 
(hexadecimal).



MOSAIC

Identifier:NLDMOS

The NLDMOS DataPlus set returns Experian’s MOSAIC demographic data for The 
Netherlands.

Element Code Description

MOSAIC Type Code TypeCode MOSAIC Type code
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MOSAIC Type Name TypeName MOSAIC Type name

MOSAIC Dutch Type 
Name

DutchTypeName
MOSAIC Dutch Type 
name

MOSAIC Group Code GroupCode MOSAIC Group code

MOSAIC Group Name GroupName MOSAIC Group name

MOSAIC Dutch Group 
Name

DutchGroupName
MOSAIC Dutch Group 
name



Using This Data

This chapter provides search tips and other product-specific information when using 
QuickAddress Pro, QuickAddress Pro Web, or QuickAddress Batch.
9

These searches are accurate at the time of data release. However, search results 
may differ depending on the data release you are using.

With QuickAddress Pro

Forms of Address

Forms of address are referred to as Country Views in QuickAddress Pro version 6 
and earlier.

The Netherlands dataset contains several Forms of address, as described on page 
5. The default layout will return addresses in the default Form of address. If you want 
to return addresses in a different Form you must set up additional address layouts. 
You can either use the Configuration Editor or manually edit the configuration files.



Using the Configuration Editor

You can add a new layout in the Configuration Editor with the following steps:

1) In the Configuration Editor Layout Manager, double-click on The Netherlands. 
This expands the list of layouts that are set up.

2) Click on the New layout button on the toolbar. Alternatively, from the Layout 
menu, click New, or right-click The Netherlands and choose New from the 
menu.
10

A dialog opens listing the available Forms of address.

3) Select the Form of address you want to use and click OK. The new layout is 
added to the bottom of the layout list.

4) Rename the new layout. For example, if you added a layout based on the TPG 
Form, you might rename the layout “Post Office”. You can rename the layout at 
any time by right-clicking it in the list, and selecting Rename from the menu.

5) You can assign a hotkey for the new layout. When Pro is minimised, using a 
layout-specific hotkey will pop up the program and automatically select that 
layout.

To assign a hotkey, click on the Hotkey field in the Layout Properties pane and 
press the keys you want to assign. For example, if you have added a TPG layout, 
click in the Hotkey field and press CTRL + P. When Pro is minimised, this hotkey 
pops up Pro in the your TPG layout.

It is recommended that you choose a hotkey not already in use by Pro (see the 
“Available Keystrokes” topic in the Pro Help). You should also avoid common 
hotkeys, for example, CTRL + A, which in many Windows applications means 
“Select All”.
For more information about hotkeys, see the Configuration Editor Help.

6) Save the changes you have made in Configuration Editor by clicking the Save 
button in the toolbar, or clicking Save from the File menu, or pressing CTRL + S.

7) Close the Configuration Editor. The changes you have made will not take effect 
until you have closed and restarted Pro.



You can change the current layout in Pro Plug & Go by clicking Select Layout… from 
the View menu or pressing CTRL + L. The Select Layout dialog opens. Choose the 
required layout from the list.

You can change the layout at any stage of your search. To view a returned address 
in a different layout, simply click Select Layout… from the View menu, or press 
CTRL + L, and click the layout.
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If you drag the Select Layout dialog to the side of Pro, you can preview the changes 
in the final returned address as you browse different layouts.

Editing the Configuration Files

To manually set up an output address layout in your Pro configuration files you will 
need to use the CDFVariaton keyword with the number of the Form of address as 
listed in the table on page 5. For example, to set a Netherlands datamapping with the 
identifier NLD to use the NEN Form you would add the following setting to your 
layout:

NLDCDFVariation=2

For more information see the configuration section of your product documentation.



Search Examples: Typedown

The following table provides a list of these example search types:

• Full address known

• Postal code not known
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• PO Box number known.

Search type Example

Full address known 1) Enter the postal code, 4043, and press Enter.
2) Enter the first three letters of the street name, ace, 

and Enter. In this example, ace is enough to 
uniquely identify Acerstraat.

3) Enter the premises number, 12, and press Enter.
4) The correct address is returned:

Acerstraat 12

4043 NX  OPHEUSDEN

Postal code not 
known

1) Enter the location, bourtange, and press Enter.
2) Enter the first two letters of the street name, pi, and 

press Enter. In this example, pi is enough to 
uniquely identify Piketlaan.

3) Enter the premises number, 3, and press Enter.
4) The correct address is returned:

Piketlaan 3

9545 TL  BOURTANGE

PO box number 
known

1) Enter the postal code or location, in this example 
aalden, and press Enter.

2) Enter postbus and press Enter.
3) Enter the PO Box number, 12, and press Enter.
4) The correct address is returned:

Postbus 12

7854 ZG  AALDEN



Search Examples: Single Line

The following table provides a list of these example search types:

• Full address known

• Postal code not known
13

• Only street name known

• Character missing from address

• Address contains spelling mistake

• Incomplete address element (partial)

• Incomplete address element (tagged)

Search type Explanation

Full address known Enter the street and premises number followed by the 
postal code: 

bisonstraat 5,3089
The correct address is returned:

Bisonstraat 5

3089 RB  ROTTERDAM

Postal code not known If the postal code is not known, enter the street name 
and premises number followed by the locality:

poterstraat 4,horn
The correct address is returned:

Poterstraat 4

6085 EW  HORN

Only street name 
known

If only the street name is known, entering it  will return 
a picklist from which the correct one can be selected.

Enter Hoofdstraat to view a list of every street of that 
name in the country.



Character missing 
from address

If one character is missing from the address the 
unknown character can be replaced with a question 
mark.

Enter god?acker 42,franeker and the correct 
address is returned:

Godsacker 42

8801 LN  FRANEKER

Search type Explanation
14

Search Constraints

The following search constraints can be used to restrict searches when using the 
Single Line search engine in Pro or Batch Interactive.

Address contains 
spelling mistake

Entering an address that contains one or more 
spelling errors can still return the correct address.

Entering tranaat 5,5629 will still return the correct 
address:

Granaat 5

5629 HH  EINDHOVEN

Incomplete address 
element (partial)

If you only have partial address information, you can 
replace the remainder of an address element with an 
asterisk. 

Entering langestraat,am* will display a picklist of 
streets called langestraat in all places beginning 
“Am…”.

Incomplete address 
element (tagged)

Sometimes it is helpful to tag a part of the search 
string to let Pro know which part of the address it is. 
See below for a list of search constraints.

Searching on groot*@t tells Pro to display a picklist 
of towns beginning “Groot…”.

Constraint Elements Restricted to Example

@S Street daar*@s

@T/@W Town/city raam*@t

@X Postal code 1*@x,



With QuickAddress Pro Web

The Netherlands dataset contains several Forms of address, as described on page 
5. Pro Web integrations can be configured to use address elements relating to any 
Form of address. Refer to your Pro Web documentation for configuration 
instructions.

Details of how Forms of address can be configured are provided on page 9.

Scenarios
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The following table indicates the relevant search examples for each Pro Web 
scenario and search engine that supports NLD address data.

Scenario
Search 
engine

For search examples, see:

Address Capture 
on the Intranet

Single Line 
hierarchical

Single Line search examples on page 13.

Address Capture 
on the Web

Single Line 
flattened

Single Line search examples on page 13.

Address Verification 
on the Web

Verification Verification search examples on page 16.

Address Capture Single Line 
flattened

Single Line search examples on page 13.

Address Verification Verification Verification search examples on page 16.

Single Line Single Line 
hierarchical

Single Line search examples on page 13.

Standard Typedown

Single Line 
hierarchical

Typedown examples on page 12.

Single Line search examples on page 13.

ActiveX Control Typedown

Single Line 
hierarchical

Typedown examples on page 12.

Single Line search examples on page 13.



Search Examples: Verification

Users of QuickAddress Pro Web can use address verification functionality to verify a 
customer’s address once they have typed it in full into a web form.

The following table provides a list of example searches and the Verify level they 
return.

Verify level Example

Verified Koepoortstraat 25
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For more information about the Verification engine, refer to the Address Verification 
section of the QuickAddress Pro Web Integration Guide.

4543 AR  ZAAMSLAG
This search brings back a verified address with the verify 
level of “Verified”.

None Missing Street
Unknown Town
This search brings back a verify level of “None” as the 
address does not exist in the data.

StreetPartial Aeluwelaan
8861 VA  HARLINGEN
This search brings back a verify level of “StreetPartial” 
as the search did not define a property number for the 
street location “Aeluwelaan”.

InteractionRequired Duizeleg 15
5521 AA  EERSEL
This search brings back a verify level of 
“InteractionRequired” because the street name was not 
correct and, although there was only one match, the 
address requires verification from the user.

Duizelseweg 15
5521 AA  EERSEL



With QuickAddress Batch

If you are using Batch to clean your database against more than one dataset, 
DataPlus information cannot be configured.

This section details the information relevant to using Batch with Netherlands address 
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data.

Forms of Address

In Batch Standalone, the default Form of address is selected for your output layout. 
If you want to use a different Form of address you must ‘fix’ the relevant elements to 
your output layout during session configuration. Elements relating to other Forms are 
found in the Additional submenu of the Fix Element dropdown list on the Set 
Output Layout screen. For more information about fixing elements to your layout, 
see the Batch documentation.

Batch API integrations can be configured to use address elements relating to any 
Form of address. Refer to your product documentation for address layout 
configuration instructions.

Country-Specific Input Fields

When configuring a Batch session, it is possible to attach a country-specific item to 
an input field. This can speed up the cleaning process as Batch does not have to 
work out which address element is contained within a field. The country-specific 
items that can be attached to an input field are shown in the following tables:

Item Field Contains

Organisation Organisation

Street line/Postbus NEN/TPG/Official street, House number, Postbus 

Street line NEN/TPG/Official street

Premises only House number



Postbus Postbus 

Postcode/Place Postal code, NEN/TPG/Unofficial town/city, Province 

Postcode Postal code

Place NEN/TPG/Unofficial town/city, Province 

Country Country/ISO code 

Item Field Contains
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Available Country-Specific Menu Items

The country-specific items available from the Advanced sub-menu are:

The address items on the Advanced sub-menu can be input in any combination. For 
example, it is possible to attach the Town/City and Postcode to the same field. This 
is not possible from the main Select Input Fields menu. For instructions on how to 
configure country-specific input fields, refer to the documentation that accompanies 
your copy of Batch.

Item Field Contains

Street NEN/TPG/Official street

Premises House number

Postbus Postbus

Postcode Postal code

Town/City NEN/TPG/Unofficial town/city

Province Province

Country Country/ISO code 



Country-Specific Information Bits

NLD-Specific Information Bits

When using NLD data a selection of country-specific information bits can be 
returned.

• For Standalone users, NLD-specific information bits are returned as the first 8 
digits of the 16-digit extended match result as displayed in Interactive.

• For API users, these are returned by the function QABatchWV_GetMatchInfo 
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as parameter rlCountryInfo1, and from the function QABatchWV_Clean in the 
parameter rsReturnCode from the 13th to 20th characters. Refer to the 
QuickAddress Batch manual for further information about these functions.

The following table provides a full list of NLD-specific information bits that can be 

returned.

Search Examples: Batch Interactive

For information about the best methods for searching on Netherlands addresses 
using Batch Interactive please refer to Single Line search examples on page 13 and 
Typedown search examples on page 12.

Information Bit Description

01000000 The town has been added or altered.

02000000 Batch has found an NEN town/city match.

04000000 Batch has found a TPG town/city match.

08000000 Batch has found an unofficial town/city match.

00100000 The street name has been changed.

00200000 Batch has found an NEN street match.

00400000 Batch has found a TPG street match.

00800000 Batch has found an official street match.

00010000 The supplied house number/extension has been amended.
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